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Editing documents

Press ENTER or any letter/digit to edit the contents of the current cell. To accept new data press ENTER once again 
or use one of the following cursor keys: UP ARROW, DOWN ARROW, PAGE UP (+CTRL), PAGE DOWN (+CTRL). 
Pressing ESC will return the original value. You can enter up to 256 characters. To add quickly an address of a 
particular cell to the currently edited cell, press SHIFT and click this cell with the left mouse button.

If you want to view and scroll different parts of your document independently, use the Split command from the 
Window menu to split the worksheet pane.

To scroll the document contents, you can use the following keys: UP ARROW, DOWN ARROW, PAGE UP (+CTRL), 
PAGE DOWN (+CTRL), LEFT ARROW (+CTRL), RIGHT ARROW (+CTRL), HOME, END, CTRL+HOME (scrolls to the 
intersection of the first column and first row), CTRL+END (scrolls to the intersection of the last column and the last 
row).

You can select cells using mouse or the SHIFT key. If you want to select a group of objects (OLE objects, charts, 
rectangles, ellipses), you must press and hold down the SHIFT key and click the desirable objects.

GS-Calc enables you to store unlimited numbers of worksheets in one document. You can organize and manage 
them in a variety of ways to make it easy to locate the worksheet you want. After activating the worksheets' tree 
pane you can use standard cursor keys to browse available worksheets. The LEFT ARROW and RIGHT ARROW keys 
are used to collapse and expand the selected folder. To edit the name of the selected item press ENTER or double-
click it. Pressing any letters causes searching for an item whose name begins with these letters. Selected 
worksheets, highlighted by a small blue arrow, are automatically opened and displayed in the worksheet pane.

Notes

* The "last row" and "last column" terms mean the last row and last
column containing a not empty cell or a cell for which the 
background color or frame format has been set.

* The folder containing the default worksheet is always expanded 
after loading the given document

* You can change the appearance of the tree expanding or 
collapsing its folders, scrolling the current selection and changing
width of the tree pane. However, such changes are not treated as
operations that modify the document contents and you're not 
prompted to save them. In this case you have to use the Save 
command before closing the document.

Related Topics

Entering text, numbers, dates and formulas
Adding, deleting, renaming and moving folders and worksheets
Functions
Operators



Entering text, numbers, dates and formulas

GS-Calc automatically recognizes the type of the entered data. The type of the cell contents is displayed in the first 
row of the document window. This can be Text, Number or Formula. By default, text cells are left-aligned. If you 
want the given formula or number to be treated as text, you may enter the apostrophe (') as the first character (e.g.
'3/4+1). Numbers having more than 15 digits are displayed in exponential format unless you use a user-defined 
style. You may use both the point (.) and the currently system-defined decimal separator when typing decimal 
places in numbers. If the length of a number exceeds a column width, the program displays a string of "#" 
characters.

If you set the currency format for some cells, you can enter numbers using the currency format defined in Regional 
Settings in Control Panel, for example: $1,500.90 or DM 1.500,90.

Date/time values can be entered as numbers or as formatted strings. The (positive or negative) date/time number 
consists of the integer portion representing the number of days since 30 December 1899, midnight and the 
fractional portion representing hours (that is, 1 day -> 1, 1 hour -> 1/24, 1 minute -> 1/24/60, etc.; "1/01/2099" = 
72686, "1/1/1680" = -80531, "6:00 PM" = 0.75).
If you set the date/time format for some cells, you can also enter date/time values as formatted strings using the 
short date format defined in Windows Regional Settings. For example, if you define that format as "M/d/rr" and 
"h:mm:ss tt", the following expressions will be valid: "1/01/2099", "1/1/1999", "11:00 AM 1/1/1680", "1/01/99 11:00 
AM", "11:00:45 PM". For "MMM-d-rrrr" this can be: "Jan-1-2099", "May-30-1999", etc.
The valid date range is 1 January 100 – 31 December 9999.

Formulas can begin with = or + (although it is not necessary). To display and print formulas instead of their values, 
clear the "Display values of formulas" checkbox in the Options dialog box.
If you enter one or more formulas containing recurrent expressions (for example, B1 into the A1 cell and A1 into 
B1), the program displays a list of cells causing such an iterative recalculation as the status bar message. The 
recurrence level can be changed in the Options dialog box.

When entering formulas you may use absolute or relative cell addressing. If you copy formulas from one cell to 
another, GS-Calc changes the relative addresses to reflect this movement. For example, "A1" copied from B1 to B2 
will be replaced by "A2". To avoid this, enter a dollar sign ($) before columns (to preserve the column number) or 
rows (to suppress the row change), e.g. $A$1, $A1, A$1. Clearing the "Modify cell addresses when copying 
formulas" checkbox in the Options dialog box has the same effect (the shortcut is ALT+INSERT).

Examples

Numbers Text Formulas
5
5.56
12.45e+12
-1995
23%

abc
GSCALC
Table
'123
'A1/45
"123"

A1+A2
A1:B5
$A1+A$2+$A$3
A1/A2+FACT(A3)
"ab" & 
IF(A1="cd";A2;A3)
FVAL(1000;3%;A1)
FVAL(1000;0,03;A1)

Related Topics

Using definable number styles
Functions
Operators



Inserting graphics

To insert text, frames or tables as a graphics:
1. Select the data you want to use and choose the Copy command from the Edit menu.
2. Using the Paste special command from the Edit menu and selecting the "Graphics" format insert a new object 
into your document.



Using Drag-Drop functions

Use the Drag-Drop functions to copy cells and objects, copy or move entire worksheets or folders containing 
worksheets, or to open an existing GS-Calc document. To open an existing document drag its name from within 
Explorer window to the GS-Calc window.



Copying cells and objects

Use the Edit menu commands or Drag-Drop functions to copy cells or objects. To copy data using Drag-Drop 
functions:
1. Point to a cell, or select a range or object(s) you want to copy.
2. Press and hold down the CTRL key and using the left mouse button drag the selection to the new location.
3. Release the CTRL key and the mouse button to finish copying.

The Drag-Drop functions enable you to copy data within the same document, different GS-Calc documents or 
different applications. By default, GS-Calc creates an embedded object. If you want to paste a link into another 
application press and hold down the SHIFT key.



Using OLE functions

GS-Calc is an OLE client and server. It supports in-place-editing and Drag-Drop functions. GS-Calc objects inserted 
into other applications look like documents printed directly by GS-Calc. The size of the metafile (picture) 
representation of such objects is always limited to (approx.) 2000x2000 pixels.
GS-Calc activated in-place doesn't display the tree pane - you must open it in the full-window mode. Changing the 
in-place-edited object's size results in increasing the number of displayed cells. To change the size of the given 
linked GS-Calc object you may also change its name in the client application. This name includes four coordinates 
describing visible cells.

If you copy a chart to another program, GS-Calc creates an OLE object which consists of the smallest range of cells 
covering both the chart and the cells where its data are placed.
GS-Calc doesn't support inserting GS-Calc objects into its own documents.



Editing text files

When saving text files, you can define any character as the cell separator. Cell values containing this separator, 
double quotation marks (") or CR/LF characters are enclosed in double quotation marks (the inner quotation marks 
are doubled). You may specify some additional options: saving formulas or their values, saving formatted numbers 
or whether the entire current folder should be saved.



Editing databases

GS-Calc enables you to use all the most popular databases/spreadsheets formats. To see the full list of available 
formats, please check the File Type drop-down list in the Open and Save Copy As dialog boxes.
After opening a database, worksheet rows contain subsequent records. You may edit databases like any other GS-
Calc document. GS-Calc performs text length validation as text fields are modified. Use the Update Records 
command to save modified fields.
Note: GS-Calc saves the current selection. If you don't select any cells, only one field of a single record pointed by 
the current cell will be updated.

If you want to add new records, enter your data to cells below the last row and save them. If you want to delete one
or more records, use the Remove Rows command from the Tools menu.

When importing and exporting databases, GS-Calc uses the following field types:

Type Length
in bytes

Description

Text 0-255 Text and numbers.
Memo * Lengthy text. A Memo field's size is limited by the 

maximum size of the database.
Long 4 Integer values from 2,147,483,648 to 2,147,483,647.
Boolean 1 Yes/No, True/False, 1/0. A field that contains only 

one of two values.
Byte 1 Positive values from 0 to 255. 
Integer 2 Integer values from –32,768 to +32,767.
Single 4 3.402823E38 to 1.401298E–45 for negative numbers

and 1.401298E–45 to 3.402823E38 for positive 
numbers.

Double 8 Values from 1.79769313486232E308 to 
4.94065645841247E–324 for negative values and 
4.94065645841247E–324 to 
1.79769313486232E308 for positive values. 

Date 8 Dates and times (stored together). These values are 
stored in a 8-byte field and may be treated as a 
(positive or negative) 8-byte floating point number. 
The integer portion represents the number of days 
since December 30, 1899, midnight and the 
fractional portion represents hours.

Long 
binary

* Any value that can be represented in binary (like 
pictures or OLE objects created in other programs) 
up to 1.2 gigabytes in size. 

Currency 8 Used for monetary values. This data type maintains 
a fixed number of digits to the right of the decimal 
point, which helps in avoiding improper rounding 
during calculation.

If you choose a field type that doesn't apply to the given format, the type that matches it as close as possible will 
be used. Please note that GS-Calc doesn't display the contents of binary fields and doesn't save binary and memo 
fields.

Notes

* GS-Base treats Excel files as tables and does not use or convert any 
formulas when reading, modifying and creating the *.xls files. To open a 
range of cells in an Excel table, specify the table name followed by a 



dollar sign and the starting and ending cells of the range (e.g. 
SHEET1$A1:B5).

* By default, GS-Calc saves empty source record fields as empty destiny 
record fields. If you want any text to be used instead of empty fields, 
edit the NullString entry in the
HKEY_CURRENT_USER\Software\JPS Development\GS-Base\
Settings
key in the registry database.

* The program opens Access databases (*.mdb) in the read/write mode. To
open an Access database placed on CD-ROM or any other read-only 
media, you must copy it on your hard disk and remove the read-only file 
attribute.



Editing charts and OLE objects

To edit a chart, a rectangle or an ellipse double-click it. GS-Calc displays the Rectangle, Ellipse or Chart dialog 
box which enables you to modify its appearance. Double-clicking an OLE object causes performing the first 
command from the Edit/Object menu. Usually, this means activating and in-place-editing. If you press and hold 
down SHIFT key, the subsequent command (if exists) from the same menu will be performed.

To change the size of an OLE object, chart, ellipse or rectangle, click it and drag one of the eight points displayed 
around it as necessary.

If you use commands from the Object menu instead of double-clicking, you will save some memory if the current 
undo level is greater than 0 (the copy of the original object is not created), but you will not be able to undo any 
changes of this object.

Related Topic

Chart command
Data dialog box



Using DDE commands

You may use the DDE commands to enter data into the GS-Calc document. The DDE "execute" command should 
have the following form:
[insert(file_name,column,row,value]
There should be no whitespaces between parameters and each parameter should be enclosed in quotation marks. 
For example:
[insert("d:\gscalc35\analyze.gsc","2","11","4.5")]
The value parameter may represent a number or a text string. After accepting a new cell GS-Calc performs 
recalculation and updates charts and associated OLE server items.

To open or print a document you may also use the following commands
[open(file_name)]
[print(file_name)]
[printto(file_name,printer_name,driver_name,port_name)]

When creating the application and item atoms during the DDE initiation use the "gscalc" and "system" text string.



Changing the decimal and group separators

GS-Calc uses the decimal separator and the group separator defined in Regional Settings. You may change them 
using Control Panel.



Changing the currency, date and time formats

GS-Calc uses the formats defined in Regional Settings. You may change it using Control Panel.



Changing the default font

GS-Calc saves some its parameters in the registry database. It uses the following key name:

HKEY_CURRENT_USER\Software\JPS Development\GS-Calc\Settings

Change value of the MainFont entry in this key to change the global font used by GS-Calc. The default name is 
"Arial".



Printing worksheets

When you print a single worksheet after choosing the Print command from the File menu, you can print the entire 
worksheet, specified pages or the current selection: a range, OLE objects, charts, rectangles or ellipses.
If you use the Print All command from the same menu, GS-Calc prints all pages of all worksheets in the current 
folder and its subfolders one after another. In this case the default printer settings are used.
Using the Page Setup command you can change page margins, adjusting, centering and specify additional 
information that can be printed in headers and footers: the document name, worksheet name, data and time, page 
numbers or any text. 
Page settings are stored separately for each worksheet. To make them the same within the current folder and its 
subfolders, use the Duplicate Data command from the Tools menu.
You can turn on or off printing (and displaying) grid lines with the Grid command from the View menu. 

Related Topic

Defining headers and footers



Searching for worksheets or cells

1. To search for worksheets, activate the tree pane and use the Find Worksheet/Cell command from the Edit 
menu. You can find worksheets only if they match the filter specified in the Find dialog box.
(a) If you clear the Use simple text search checkbox:

Filters can be any regular spreadsheet expressions returning numbers. If, for the data of the given worksheet, 
the expression returns a value different than zero and "error", the worksheet will be found.

(b) If you check the Use simple text search checkbox:
Filters can be any text strings. They are compared against the (unformatted) contents of all cells from the 
given worksheet. The text can be a substring of the cell contents. The comparison is not case-sensitive.

You can sort the list of found worksheets by name, size and the last modification date.

2. To search for cells containing the given substring, activate the worksheet pane and use the Find 
Worksheet/Cell command from the Edit menu. If you select any cells before using this command, the searching 
will be limited to those cells.

Related Topic

Search expressions



Changing column widths and row heights

To change column width, drag the boundary on the right side of the column heading until the column is the width 
you want.
To change row height, drag the bottom boundary of the row heading until the row is the height you want.

If you want to specify the exact width or height in pixels or if you want to change the width or height for multiple 
rows or columns, use the Change Width/Height command from the Tools menu.



Adding, deleting, renaming and moving folders and worksheets

1. To add a new worksheet or folder use the New Folder or New Worksheet command from the Insert menu. 
New items are inserted at the end of the selected or current folder. After inserting, the program prompts you to 
enter a new name for that item. Press enter or click any other item to accept a new name.

2. To copy an existing folder or worksheet(s) do one of the following:
(a) Point to a folder or worksheet, press and hold down the mouse button and the CTRL key, and drag item to the 
new location. When dragging, the highlighted items show the current target location. You may copy single 
worksheets, empty folders or folders containing other worksheets or nested folders.
(b) Point to a folder or worksheet and use the Copy command from the Edit menu. Point to the target location and 
use the Paste command. You may copy single worksheets, empty folders or folders containing other worksheets or 
nested folders.

3. To move a folder or worksheet to the new location, repeat steps from p. 2 (a), except for pressing the CTRL key. If
the destination location is placed within the moved folder, GS-Calc performs the "copy" operation.

4. To rename a worksheet or folder, select it and press the ENTER key or double-click it.



Using definable number styles

When formatting cells GS-Calc enables you to specify how to display numbers. Apart from some common styles like 
currency or percent, you can define your own format. To specify a new style select the New item from the Style list
in the Cell Properties/Format dialog box. In the presented New Style dialog box enter your format definitions for
positive (incl. zero) and negative numbers. The format specification must has the following form:

[text] % [flags] [width] [.precision] type [text]

Examples

Format Number How it's displayed
%f 123 123.000000
%06.0f 123 000123
%09.2f 123 000123.00
$ %.2f 123.357 $ 123.36
%.f 1234567891

01
1121314

1234567891011121400

%e 123 1.230000e+002
%.3e 123 1.230e+002
%3.e 123 1e+002
%+g 123 +123
(%g) -123 (-123)
Negative -123 Negative
abc 123 abc

The optional fields, control the formatting, as follows:

text

This can be any text - not containing the "%" characters - that will be displayed along with (or instead of) numbers.

type

e Signed value having the form [ – ]d.dddd e [sign]ddd where d is a single 
decimal digit, dddd is one or more decimal digits, ddd is exactly three 
decimal digits, and sign is + or –.

E Identical to the e format except that E rather than e introduces the 
exponent.

f Signed value having the form [ – ]dddd.dddd, where dddd is one or more
decimal digits. The number of digits before the decimal point depends 
on the magnitude of the number, and the number of digits after the 
decimal point depends on the requested precision.

g Signed value printed in f or e format, whichever is more compact for the 
given value and precision. The e format is used only when the exponent 
of the value is less than –4 or greater than or equal to the precision 
argument. Trailing zeros are truncated, and the decimal point appears 
only if one or more digits follow it.

G Like the g format, except that E, rather than e, introduces the exponent 
(where appropriate).

flags

– Left align the result within the given field width.



+ Prefix the output value with a sign (+ or –) if the output value is of a 
signed type

0 If width is prefixed with 0, zeros are added until the minimum width is 
reached. If 0 and – appear, the 0 is ignored.

blank ('
')

Prefix the output value with a blank if the output value is signed and 
positive; the blank is ignored if both the blank and + flags appear.

# When used with the e, E, or f format, the # flag forces the output value 
to contain a decimal point in all cases.
When used with the g or G format, the # flag forces the output value to 
contain a decimal point in all cases and prevents the truncation of 
trailing zeros.

width

The width argument is a nonnegative decimal integer controlling the minimum number of characters printed. If the 
number of characters in the output value is less than the specified width, blanks are added to the left or the right of
the values, depending on whether the – flag is specified. If width is prefixed with 0, zeros are added until the 
minimum width is reached. The width specification never causes a value to be truncated.

precision

It specifies a nonnegative decimal integer, preceded by a period (.) which specifies the number of decimal places. 
The precision specification can cause rounding of a value.
If Type is e or E, the last printed digit is rounded. Default precision is 6. If precision is 0 or the period (.) appears 
without a number following it, no decimal point is printed.
If Type is f, If a decimal point appears, at least one digit appears before it. The value is rounded to the appropriate 
number of digits. Default precision is 6. If precision is 0, or if the period (.) appears without a number following it, 
no decimal point is printed.
If Type is g or G, the precision specifies the maximum number of significant digits printed. By default six 
significant digits are printed. Any trailing zeros are truncated.



Exchanging data between worksheets

In addition to copying and drag-drop functions, you can use the following functions to access cells from other 
worksheets:

CELL_EX
SUM_EX
MAX_EX
MIN_EX
FOLDER_COUNT
SHEET_COUNT
GETEXVAL

Related Topics

Copying cells and objects
Adding, deleting, renaming and moving folders and worksheets
Using Drag-Drop functions



Commands

File menu
Edit menu
View menu
Insert menu
Format menu
Tools menu
Window menu
Help menu



File menu

New
Open...
Save
Save As
Print
Print All
Print Preview
Print Setup
Page Setup
Password
Summary Info
Send
Exit



Edit menu

Undo
Redo
Repeat
Cut
Copy
Paste
Paste Special
Paste Link
Delete
Find Worksheet/Cell
Replace
Convert Formulas
Object Properties
Links



View menu

Status Bar
Standard Toolbar
Format Toolbar
Zoom
Grid



Insert Menu

Object
Chart
Ellipse
Rectangle
Data Series
Date/Time
Formula
New Folder
New Worksheet



Format menu

Cell Properties
Bold
Italic
Underline
Normal
Font
Remove Formatting



Tools menu

Sort
Analyze menu
Insert Column
Remove Columns
Insert Row
Remove Rows
Duplicate
Move to Foreground
Move to Background
Recalculate
Recalculate All
Options



Analyze menu

Equation System
Linear Optimization
Inverse Matrix
Determinant
Integration



Window menu

Split
Cascade
Tile Horizontally
Tile Vertically
Arrange Icons



Help menu

Help Topics
About GS-Calc



New command (File menu)

Use this command to create a new document in GS-Calc.



Open command (File menu)

Use this command to open an existing document in a new window. You can open multiple documents at once. Use 
the Window menu to switch among the multiple open documents.

Notes

You must select a proper file type from the File Types list in the Open dialog box.



Close command (File menu)

Use this command to close all windows containing the active document. GS-Calc suggests that you save changes to
your document before you close it. If you close a document without saving, you lose all changes made since the last
time you saved it.



Save command (File menu)

Use this command to save the active document to its current name and directory. If you want to change the name 
and directory of an existing document before you save it, choose the Save As command.
If you are editing a database, this command name is replaced by "Update Records".



Save As command (File menu)

Use this command to save and name the active document.



Page Setup command (File menu)

Use this command to change page layout.



Summary Info command (File menu)

Use this command to display a dialog box containing information about the current document.



Summary Info dialog box

GS-Calc displays information on the current document: the number of cells with particular contents, size of the 
document file and the date of last saving.



Summary Info dialog box

GS-Calc displays information on the current document: the number of cells with particular contents, size of the 
document file and the date of last saving.



Password command (File menu)

Use this command to change the current password.



1,2,3... command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you closed. 
Choose the number that corresponds with the document you want to open.



Send command (File menu)

Use this command to send the active document through electronic mail. This command presents a mail window 
with the active document attached to it. You may then fill out the To: field, Subject: field, etc., and add text to the 
body of the message if you wish. When you are finished you may click the "Send" button to send the message.



Exit command (File menu)

Use this command to end your GS-Calc session.



Undo command (Edit menu)

Use this command to reverse the last editing action. The name of the command changes, depending on what the 
last action was.



Redo command (Edit menu)

Use this command to redo the reversed editing action. The name of the command changes, depending on what the 
last action was.



Repeat command (Edit menu)

Use this command to repeat the last editing action. The name of the command changes, depending on what the 
last action was. This command is inactive for some types of actions.



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.

Cutting data to the clipboard replaces the contents previously stored there.

To cut:
(1) the cell contents - select cells and use this command; you can choose what should be cut:
format,
cells containing text,
cells containing numbers,
cells containing formulas,
all cells;

(2) object - select the object and use this command; if you want to select a group of objects hold down the SHIFT 
key.



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.

Copying data to the clipboard replaces the contents previously stored there.



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This command is unavailable if 
the clipboard is empty.



Delete command (Edit menu)

Use this command to remove the currently selected data from the document.

To delete:
(1) the cell contents - select cells and use this command; you can choose what should be cut:
format,
cells containing text,
cells containing numbers,
cells containing formulas,
all cells;

(2) object - select the object and use this command; if you want to select a group of objects hold down SHIFT key.



Formula command (Insert menu)

Use this command to paste a formula into the current cell. After choosing this command GS-Calc displays the Paste
Formula dialog box which enables you to retrieve all available formulas (shortcut: right mouse button + SHIFT).



Find Worksheet/Cell command (Edit menu)

Use this command to search for worksheets or to search the active document for text. The search mode depends on
whether the tree pane is active.

Related Topic

Searching for worksheets and cells



Find dialog box

Related Topic

Find command



Replace command (Edit menu)

Use this command to find and replace text in the active document. While comparing text GS-Calc uses unformatted 
cell contents.

If you select any cells before using this command, the searching will be limited to those cells.



Replace dialog box

Related Topic

Replace command



Convert Formulas command (Edit menu)

Use this command to convert the selected formulas to numbers or text strings.



Object Properties command (Edit menu)

Use this command to change properties of the selected OLE object. You can change its type, the way it is displayed,
its scaling and link.



Standard Toolbar command (View menu)

Use this command to display and hide the Standard Toolbar, which includes buttons for some of the most 
common commands in GS-Calc, such as File Open. A check mark appears next to the menu item when the toolbar 
is displayed.



Standard Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick 
mouse access to many tools used in GS-Calc.



Format Toolbar command (View menu)

Use this command to display and hide the Format Toolbar, which includes buttons for some of the most common 
commands in GS-Calc. A check mark appears next to the menu item when the Toolbar is displayed.



Format Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick 
mouse access to many tools used in GS-Calc.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected 
menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item 
when the Status Bar is displayed.



Status Bar

The status bar is displayed at the bottom of the GS-Calc window. To display or hide the status bar, use the Status 
Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through 
menus. This area similarly shows messages that describe the actions of toolbar buttons as you depress them, 
before releasing them. If after viewing the description of the toolbar button command you wish not to execute the 
command, then release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate:

Indicator Description
AUTO Formulas are recalculated automatically.
TRANS Modifying formulas after changing its location.
CAP Caps Lock is on.
NUM Num Lock is on.
SCRL Scroll Lock is on.



Zoom command (View menu)

Use this command to enlarge the view of the current document. Valid scaling factors are from 30 to 400%.



Grid command (View menu)

Use this command to hide or show the grid of the active document.



Chart command (Insert menu)

Use this command to insert a new chart. The displayed Chart dialog box enables you to select the chart type, data 
and other options affecting its appearance. Initially all data ranges are determined by the current selection (the first
column - the legend, the top row - the X axis description, the remaining cells - data series). You can change them 
using the Change button in the Data dialog box. Depending on the current settings, one data series (functions) 
may occupy a single row or a single column of the given range. Data series may be placed in one or more (up to 16)
separated ranges. If you select more than one data series range and if you want the chart to present more than one
function, all ranges must contain the same number of cells. GS-Calc uses formats of the respective document cells 
when displaying the values describing charts.

The 2D charts shown (on the chart list) with a horizontal grid use a logarithmic scale.

Charts are updated after every action that can change the document contents. To edit an existing chart double-click
it. Press and hold down the SHIFT key if you want to change the ranges for particular data series.

Related Topic

Editing charts and OLE objects
Data dialog box



Chart Type dialog box

Related Topic

Chart command



Options dialog box

Related Topic

Chart command



Colors dialog box

Related Topic

Chart command



Data dialog box

Data...
Use this button to display the Chart Data dialog box. It enables you to specify ranges for each data category.

Related Topic

Chart command



Chart Data dialog box

The following buttons enable you to specify ranges for each data category:
Data
The range which contains values of one or more data series. You may select up to 16 different ranges. To add a new 
one select a range that does not intersect the others.
X-Axis
The range containing titles used to describe the X-axis ticks. For the XY-type charts these are values of arguments 
for the chosen function(s). If the range is smaller than the number of functions defined in the Data section, the 
subsequent values are repeated when displaying a chart.
Legend
The range containing values used to display the legend of a chart.

To change any range of cells select desirable cells and click the chosen button.

Related Topic

Chart command



Data Series (Insert menu)

Use this command to insert a series of numbers or a text into the selected cells.



Ellipse command (Insert menu)

Use this command to insert a new ellipse into the active document. Double-click the inserted ellipse to specify 
additional parameters.

Related Topic

Editing charts and OLE objects



Rectangle command (Insert menu)

Use this command to insert a new rectangle into the active document. Double-click the inserted rectangle to specify
additional parameters.

Related Topic

Editing charts and OLE objects



Date/Time command (Insert menu)

Use this command to insert a date and/or time value into the selected cells.



New Folder command (Insert menu)

Use this command to insert a new folder into the worksheet tree.

Related Topic

Adding, deleting, renaming and moving folders and worksheets



New Worksheet (Insert menu)

Use this command to insert a new folder into the worksheet tree.

Related Topic

Adding, deleting, renaming and moving folders and worksheets



Cell Properties command (Format menu)

Use this command to change the properties of the selected cells. You may change the style, alignment, displaying 
options, colors, frame and shadows.



Bold command (Format menu)

Use this command to select bold format.



Italic command (Format menu)

Use this command to select italic format.



Underline command (Format menu)

Use this command to select underline format.



Strikeout command (Format menu)

Use this command to select strikeout format.



Normal command (Format menu)

Use this command to select normal format.



Font command (Format menu)

Use this command to display the Font dialog box which enables you to specify font name, size, style, color and 
effects.



Font dialog box

Related Topic

Font command



Remove Formatting (Format commands)

Use this command to remove formatting for the selected cells.



Sort command (Tools menu)

Use this command to sort the selected cells. The first column of the current range is treated as the sort key. If you 
don't select any cells, the program will sort the current column.



Equation System command (Tools menu)

After using this command GS-Calc displays the Equation System dialog box which enables you to solve linear 
equations.



Linear Optimization command (Tools menu)

After using this command GS-Calc displays the Linear Optimization dialog box which enables you to find optimal 
solutions using linear programming.



Inverse Matrix command (Tools menu)

After using this command GS-Calc displays the Inverse Matrix dialog box which enables you to inverse matrixes.



Determinant command (Tools menu)

After using this command GS-Calc displays the Determinant dialog box which enables you to calculate 
determinants of matrixes.



Integration command (Tools menu)

After using this command GS-Calc displays the Integration dialog box which enables you to perform integration of 
functions.



Analyze dialog box

Equation System
Linear Optimization
Inversion of Matrix/Determinant
Integration



Equation System dialog box

To solve an equation system:
1. Select cells containing variables and click the Variables button.
2. Select cells containing constants and click the Constants button. The number of these cells must be equal to 
the number of rows selected in step 1.
3. Select cells which will contain the result and click the Result button. The number of these cells must be equal to 
the number of columns selected in step 1.
4. Click the OK button.

Example

the equation system
x + 2*y + 4*z = 24
2*x + z = 13
5x - y - z = 15
can be expressed in the following way:

Variables - B3:D5
Constants - E3:E5
Results - B6:D6



Linear Optimization dialog box

To find a solution using linear optimization:
1. Select cells containing variables and click the Variables button.
2. Select cells containing constants and click the Constants button. The number of these cells must be equal to 
the number of rows selected in step 1.
3. Select cells containing optimized function factors and click the Function button. The number of these cells must 
be equal to the number of columns selected in step 1.
4. Select cells which will contain found variables and function value and click the Result button. The number of 
these cells must be equal to the number of columns selected in step 1 plus one for the function result.
5. Click the OK button.
Note: The result may include a few symmetric solutions.

When finding the solution GS-Calc maximizes the given function.

Example

Problem
x <= 4500
-0.65x + 0.35y <= 0
5x + 8y -> max
can be expressed in the following way:

Variables - B11:C12
Constants - D11:D12
Function - B14:C14
Results - B15:D15



Inversion of Matrix dialog box

To find an inverted Matrix
1. Select cells containing the matrix and click the Data button.
2. Select cells which will contain the result. The number of these cells must be equal to the number of cells selected
in step 1.
3. Click the OK button.

To find a determinant
1. Select cells containing the matrix and click the Data button.
2. Select the cell which will contain the computed value and click the Result button.
3. Click the OK button.



Integration dialog box

To perform integration:
1. Select cells containing parameters and click the Parameters button. The range must contain the following 
values:

the top integration limit,
the bottom integration limit,
the precision as a percentage.

The integrated function can have no values in the limit points.
2. Select the cell containing the function and click the Function button. This function may consist of any formulas 
and numbers. The variable must be expressed as the "x" character.
4. Select the cell which will contain the result and click the Result button.

Example

Parameters - B5:D5 (integration from 1 to 100 at 0.01% relative precision)
Function - B6
Result - B7



Insert Column command (Tools menu)

Use this command to insert a new column. Inserting column may result in modifying formulas.

Example

If you insert the D column, the formula E1+E2 from the A1 cell will be replaced by F1+F2.



Remove Columns command (Tools menu)

Use this command to delete selected columns. Deleting columns may result in modifying formulas.
Example:
If you delete the D column, the formula E1+E2 from the A1 cell will be replaced by D1+D2.



Insert Row command (Tools menu)

Use this command to insert a new row. Inserting row may result in modifying formulas.

Example

If you insert the 10th row, the formula E100+E200 from the A1 cell will be replaced by E101+E201.



Remove Rows command (Tools menu)

Use this command to delete selected rows. Deleting rows may result in modifying formulas.

Example

If you delete the 10th row, the formula E100+E200 from the A1 cell will be replaced by E99+E199.



Change Width/Height (Tools menu)

Use this command to change the width or height of selected columns or rows.

Related Topic

Changing column widths and row heights



Duplicate command (Tools menu)

Use this command to copy data of the selected type from the current worksheet to all other worksheets in the 
current folder and its subfolders. This is an easy way to make the same: column widths, row heights, formats, 
selection, current view coordinates or page settings.



Move To Foreground command (Tools menu)

Use this command to move the selected object(s) before any other objects.



Move To Background (Tools menu)

Use this command to move the selected object(s) behind any other objects.



Recalculate command (Tools menu)

Use this command to recalculate all formulas within the active worksheets.



Recalculate All (Tools menu)

Use this command to recalculate all worksheets in the active document.



Options command (Tools menu)

Use this command to display the Options dialog box which enables you to change the program settings.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Split command (Window menu)

Use this command to split the active window into panes. You may then use the mouse or the keyboard arrows to 
move the splitter bars. When you are finished, press the mouse button or enter to leave the splitter bars in their 
new location. Pressing ESC keeps the splitter bars in their original location.



Arrange Icons command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main window. If there is an 
open document window at the bottom of the main window, then some or all of the icons may not be visible because
they will be underneath this document window.



1,2,3... command (Window menu)

GS-Calc displays a list of currently open document windows at the bottom of the Window menu. A check mark 
appears in front of the document name of the active window. Choose a document from this list to make its window 
active.



Help Topics command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-step 
instructions for using GS-Calc and various types of reference information.



About GS-Calc command (Help menu)

Use this command to display the copyright notice and version number of your copy of GS-Calc.



Context Help command

Use the Context Help command to obtain help on some portion of GS-Calc. When you choose the Toolbar's Context 
Help button, the mouse pointer will change to an arrow and question mark. Then click somewhere in the GS-Calc 
window, such as another Toolbar button. The Help topic will be shown for the item you clicked.



Title Bar

The title bar is located along the top of a window. It contains the name of the application and document. To move 
the window, drag the title bar.



Scroll Bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars indicate 
your vertical and horizontal location in the document. You can use the mouse to scroll to other parts of the 
document.



Format Toolbar

Use the Format Toolbar buttons to set or remove various formats for the selected cell(s). You can also do the same
using the Cell Properties dialog box.



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Installing GS-Calc

System requirements: PC with Windows 95/98/NT

To install GS-Calc, run the SETUP.EXE program.

To import and export files in formats other than text, GS-Calc uses the DAO v. 3.5 database drivers. If DAO has not 
been installed in your system by other programs, the following files will be copied to the (Windows) system 
directory.

DAO350.DLL    (to the \Program Files\Common Files\Microsoft Shared\Dao directory)
DAO2535.TLB    (to the \Program Files\Common Files\Microsoft Shared\Dao directory)
MSJET35.DLL
MSVCRT40.DLL
MSJINT35.DLL
MSJTER35.DLL
EXPSRV.DLL
VBAJET32.DLL
MSRD2X35.DLL
MSXBSE35.DLL
MSEXCL35.DLL
MSLTUS35.DLL

Running the Uninstall program causes removing DAO from the Windows registry database (unless the reference 
count indicates that it's used by other installed programs).

Note: GS-Calc uses these DLLs exclusively for importing and exporting data to the various formats.



Customer support

If have any problems with this product or if you have any suggestions, please contact:

E-mail: support@jps-development.com
Web: http://www.jps-development.com

JPS Development
ul. Chopina 13
58-100 Swidnica, Poland

tel.:    +48-74-537581
fax:    +48-74-537581



No information

No information on this topic.



No information

No information on this dialog box.



To change this data select the document cells and click this button. Click OK to update the chart.



Specifies the color you want to use to display the background.



Specifies the color you want to use to display the chart, its legend and titles.



Specifies how to fill the chart interior. If you choose Colors, it will be filled with solid colors. Otherwise it will be filled 
with six predefined patterns.



Specifies the colors used to display subsequent functions. Click one of the buttons to change the desirable color.



Click this button to restore the default color set.



Specifies whether the grid should be displayed and printed.



Specifies the Z-order used to display data series on 3D charts. If you choose this option the default order will be 
reversed.



Specifies whether values of a single data series are placed in a single row or in a single column.



Specifies whether a legend should be displayed.



Specifies whether a description of the X axis (titles at the X axis ticks) should be displayed.



Clear this option to display on the Y axis the smallest range of numbers containing all function values. If you check 
this option, the Y axis will start from 0 if there are no negative function values, or from possibly the biggest negative
value otherwise.



Specifies the number of ticks displayed on the Y axis. The default value is 5.



Specifies the chart title. You may enter up to 80 characters.



Click this button to display the Font dialog box which enables you to change fonts.



Click this button to display the Font dialog box which enables you to change fonts.



Click this button to display the Font dialog box which enables you to change fonts.



Displays all available charts.



Some of displayed charts can be used to present a numeric relation between functions (data series) and arguments.
If you check this option, titles describing the X axis will be treated as values of arguments for the given function(s). 
The number of ticks on the X axis is equal to the number of arguments. The arguments don't have to be sorted.



Specifies the ranges containing data series. The list may consist of 16 different ranges. If you want the ranges to 
represent more than one function, they must contain the same number of cells. To add/set a new range select the 
Change button.



After selecting this button GS-Calc displays the Chart Data dialog box which enables you to change each data 
range. To display this dialog quickly, press SHIFT key and double-click the selected chart.



Specifies where the description of the X axis and the chart legend are placed.



Specifies the name of the table and its fields you want to read. A check mark which appears in front of the field 
name indicates that the field will be included. If you are opening a database which contains more than one table per
file, the name of the table may differ from the file name.



Specifies fields you want to read from the selected table.



Specifies the expression to be used as a filter for records you want to read. This may be a string conforming to the 
SQL WHERE clause syntax. You may leave this field blank.
Examples:
(1) City>="Ne" AND Number=12
(2) City<= "W" OR Number>10
(3) (April_Sales+May_Sales+June_Sales)/3>50000
(4) Title+Name="Mr.Smith" OR Title+Name="Mr.Jones"
(5) Name LIKE "*son"

Notes

You must use square brackets if the field name contains spaces or some special characters (e.g. "[Product 
number]").



Specifies whether you want to sort records.



Specifies the field that will be used as a sort key. By default GS-Calc performs ascending sorting. If you want to 
perform descending sorting, add the DESC keyword to the selected field name (e.g. "Name DESC" instead of 
"Name").

Notes

You must use square brackets if the field name contains spaces or some special characters (e.g. "[Product 
number]").



Specifies the field name in a newly created table.



Specifies the type of a field in a newly created table. You have to choose one of several predefined types. After 
retrieving spreadsheet columns the program initially selects one of them.

Type Length in
bytes

Description

Text 0-255 Text and numbers.
Memo * Lengthy text, such as comments or explanations. A Memo 

field's size is limited by the maximum size of the database.
Long 4 Integer values from 2,147,483,648 to 2,147,483,647.
Boolean 1 Yes/No, True/False, 1/0. A field that contains only one of 

two values.
Byte 1 Positive values from 0 to 255. 
Integer 2 Integer values from –32,768 to +32,767.
Single 4 3.402823E38 to 1.401298E–45 for negative numbers and 

1.401298E–45 to 3.402823E38 for positive numbers.
Double 8 Values from 1.79769313486232E308 to 

4.94065645841247E–324 for negative values and 
4.94065645841247E–324 to 1.79769313486232E308 for 
positive values.

Date 8 Dates and times (stored together). These values are stored
in a 8-byte field and may be treated as a (positive or 
negative) 8-byte floating point number. The integer portion
represents the number of days since December 30, 1899, 
midnight and the fractional portion represents hours.

Long 
binary

* Any value that can be represented in binary (like pictures 
or OLE objects created in other programs) up to 1.2 
gigabytes in size.

Currency 8 Used for monetary values. This data type maintains a fixed 
number of digits to the right of the decimal point, which 
helps in avoiding improper rounding during calculation.

Specifies the length of a field in a newly created table. Only text field length can be changed.



Specifies the list of currently defined fields. To change properties of a given field select it and edit its description.



Specifies the columns or rows you want to delete.



Ascending sorting of selected data.



Descending sorting of selected data.



Specifies whether the reverse order of words should be used when comparing. For example, if some fields contain 
two names:

Tom A. Jones
Mark Smith

GS-Calc will use the following keys:

Jones A. Tom
Smith Mark



Specifies the sort keys. You can define more than one key to perform two- or three-level sorting.



Specifies the type of data that will be inserted into the active document.



Specifies the first inserted value. The number of cells in the data series depends on the size of the current selection.



Specifies the text which has to be inserted. The number of cells in the data series depends on the size of the current
selection.



Specifies the number of empty cells between each two inserted elements of the data series. The cell values are 
inserted in lines from left to right and from top to bottom.



Specifies the step by which subsequent values are incremented. This can be any number or formula returning 
numbers. The number of cells in the inserted data series depends on the size of the current selection.



Specifies the horizontal alignment for the selected cells.



Specifies the vertical alignment for the selected cells.



Specifies the style for the selected cells.



Specifies the number of decimal places you want to use while displaying numbers.



Specifies whether separators in numbers in numbers should be displayed.



Specifies whether the cell contents should be displayed in multiple lines within the same cell.



Specifies whether the selected cells should be protected.



Specifies whether the contents of the selected cells should be hidden.



Specifies the cell color.



Specifies the pattern to be used to fill the selected cells.



Specifies whether the selected cell color should be applied.



Specifies whether the selected font color should be applied.



Specifies whether the selected shadow should be applied.



Specifies the shadow color.



Specifies the horizontal and vertical offset of a shadow. These values are treated as a percentage respectively of 
the average character width and height.



Specifies whether the frames with selected edges should be displayed.



Specifies the frame edges you want to display.



Specifies the frame thickness.



Specifies the frame color.



Specifies whether you want to use round frames.



Specifies whether you want to display frame around the current selection.



Specifies the group of formulas.



Displays all formulas from the selected group. To paste one of them into the active document double-click it.



Displays descriptions of formulas.



Specifies the current password. The password can consist of 15 characters.



Specifies the current password. The password can consist of 15 characters.



Specifies whether you want the password to be checked only when saving the document. Otherwise it will be 
checked each time you try to open the document.



Specifies the current password.



Specifies the text printed at the top (header) and at the bottom (footer) of each printed page. It may contain up to 
80 characters. You may place the following special characters within this text:
&f Filename
&w Worksheet name
&s File date
&z File time
&d Current system date
&e Current system date (long format)
&t Current system time
&p Page number
&l Left aligned (starting from the next character and up to 

the end or to &r/&c characters)
&r Right aligned (starting from the next character and up to

the end or to &l/&c characters)
&c Centered (starting from the next character and up to the

end or to &l/&r characters)

Specifies the position of headers and footers.



Specifies whether you want to start the page numbering and the printing headers or footers from the first page.



Specifies whether to print row and column headers.



Specifies whether you want to shrink the printed document so that it can be printed on a single page.



Specifies how the current document should be scaled when printing.



Specifies the width of each margin on printed page.



Specifies whether you want to center printed cells horizontally or vertically.



Specifies the line thickness.



Specifies the line color.



Specifies the interior color.



Specifies whether you want to display the object interior.



Specifies whether you want the rectangle corners to be round.



To choose a new data range select cells and click the desirable button.



Specifies the author name.



Specifies the notes which will be stored with the active document file.



Specifies the title of the active document.



Specifies the subject of the active document.



Specifies the document size.



Displays the date of the last saving.



Displays the total number of folders.



Displays the total number of worksheets.



Displays the size of the current worksheet.



Displays the date when the current worksheet was modified.



Displays the number of cells containing text, formulas and numbers.



Specifies the recurrence level. This is the number of circular recalculations the program performs after finding the 
recurrence references. For example, if A1 contains A1+1 and this value is equal to 10, the final value (in A1) will be 
10. The list of cells causing such iterations is displayed as a status bar message.



Specifies whether all formulas should be recalculated after each action which may change the document contents. 
If this option is not selected, formulas are recalculated after using the Recalculate command from the Tools menu.



Specifies the undo level. You may enter values from 0 to 16347.



Specifies how the current selection should be scrolled after pressing the Enter key.



Specifies whether to display computed values of formulas.



Specifies whether the program should use only True-Type fonts when formatting. If you don't select this option, you 
will be able to apply any currently installed Windows font.



Specifies whether you want the formulas to be modified when copying or moving data. This option doesn't affect 
formulas containing the "$" operator.



Specifies whether the formulas having a constant value (i.e. not containing references) are automatically converted 
to numbers or text values.



Specifies whether the AutoComplete feature should be used when editing cells with attached drop-lists. If selected, 
this option causes GS-Calc to search the drop-list for text beginning with the characters you've already entered, 
then - if it finds such an list item - the remaining characters are automatically added to the edited text.



Specifies the displaying scale.



Specifies the character set you want to use when opening or saving the text file. If you choose DOS character set, 
GS-Calc will perform conversion from the DOS to the ANSI set.



Select the type of the cell separator you want to use when opening or saving the text file.



Specifies whether formulas or their values should be used when saving the text file.



Specifies whether formatted (containing separators and currency or percent symbols) should be used when saving 
the text file.



Specifies whether the contents of all worksheet from the current folder and its subfolders should be saved.



Operators

Operato
r

Operation Comments Precedence

= Equal Compares numbers or text strings 
(the comparison is not case-
sensitive). Example: A1 = 4    ,    B2
= "abc"

7

< Less than Compares numbers or text strings 
(the comparison is not case-
sensitive).
Example: A1 < 4    ,    B2 < "abc"

7

> Greater than Compares numbers or text strings 
(the comparison is not case-
sensitive).
Example: A1 > 4    ,    B2 > "abc"

7

<= Less than or equal Compares numbers or text strings 
(the comparison is not case-
sensitive).
Example: A1<= 4    ,    B2 <= "abc"

7

>= Greater than or 
equal

Compares numbers or text strings 
(the comparison is not case-
sensitive).
Example: A1 >= 4    ,    B2 >=    
"abc"

7

<> Not equal Compares numbers or text strings 
(the comparison is not case-
sensitive).
Example: A1 <> 4    ,    B2 <> 
"abc"

7

+ Addition Adds numbers. 6
- Subtraction Subtracts numbers. 6
& String 

concatenation
Merges text strings.
Example: A1 & "abc"    ,    "a" & "b"

6

* Multiplication Multiplies numbers. 5
/ Division Divides numbers. 5
^ To the power of Calculates the power of. 4
- Negative Changes the sign of a number.

Example: -A1
3

: Range of cells Creates a range.
Example: A1:B5

2

% Percent Specifies a number entered as a 
percentage.
Example: 12%

1



Specifies whether a drop-list should be used when editing the selected cells.



Specify the name of the drop-list to be used when editing the selected cells.



Click this button to manage lists available with the current document.



Specifies whether new values entered in the worksheet cells should be added to the selected list. Each unique value
is added only once.



Drag the slider to the new position to change the size of buttons. This may be helpful if the range displayed as the 
button text is particularly long.



Shows the state of the currently performed operation.



Click this button to stop the current operation.



Specifies the text to be used as a search filter.

If you check the Use simple text search checkbox, this can be any text that will be compared against 
unformatted cell contents of the subsequent worksheets.

If the checkbox is cleared, this must be a valid spreadsheet expression (returning a number value) that can be 
evaluated for the data of the retrieved worksheets. If the returned value is different from zero and error, the 
worksheet is added to the found list. In the simplest form it can be a constant expression, for example:
1
which causes finding all worksheets.

Examples

A1=1998
B2:B10 >= 1000
(C2="New York") * (C5="John")
HAS_OBJECT(2) + HAS_OBJECT(3)
MATCH("Alien"; A2:D7; 0)



Specifies whether the searching should be limited to the current folder and its subfolders.



Specifies how to search for worksheets.

If you check the Use simple text search checkbox, this can be any text that will be compared against 
unformatted cell contents of the subsequent worksheets.

If the checkbox is cleared, this must be a valid spreadsheet expression (returning a number value) that can be 
evaluated for the data of the retrieved worksheets. If the returned value is different from zero and error, the 
worksheet is added to the found list. In the simplest form it can be a constant expression, for example:
1
which causes finding all worksheets.

Examples

A1=1998
B2:B10 >= 1000
(C2="New York") * (C5="John")
HAS_OBJECT(2) + HAS_OBJECT(3)
MATCH("Alien"; A2:D7; 0)



Select this button to found the next matching worksheet. If found, it is added to the Found Worksheets list, then 
selected within the tree pane and opened.
The list of found worksheets can be sorted by name, size and date.



Select this button to found all matching worksheets. They are added to the Found Worksheets list. Any previous 
items are removed.
The list of found worksheets can be sorted by name, size and date.



Click this button to display or hide the list of found worksheets.



Displays the list of found worksheets. To open the given worksheet, double-click it or use the Open button. The list 
can be sorted by name, size and date.



Click this button to open the selected worksheet.



Specifies the list name.



Specify the list items. When editing, you can use copying and pasting to modify it quickly.



Click the Add, Rename and Remove buttons to add, rename or remove lists. You may create up to 65,535 lists in 
one document. They are shared across all worksheets in the given document.



Specify the category of the data to be copied to all other worksheets in the current folder and its subfolders. This is 
an easy way to make the same: column widths, row heights, formats, selection, current view coordinates or page 
settings.



Specifies whether the long date format defined in Regional Settings should be used.



Specifies whether the chosen date/time should be inserted as a date/time number or as a formatted string.



Specifies whether the current time should be included in the inserted value.



Specifies whether the current date should be included in the inserted value.



Functions

mathematical functions
statistical functions
lookup and reference functions
financial functions
date/time functions
text functions
logical functions
special functions



Mathematical functions

ABS
AND
BJ0
BJ1
BJN
BY0
BY1
BYN
CEIL
COMBNR
COMBNS
DEGREES
EVEN
EXP
EXPE
EXPM
FACT
GCD
GRANDTOTAL
INTERPOL
LOG
LOG10
LOGX
MAX
MAX_EX
MIN
MIN_EX
MOD
NOT
ODD
OR
PI
POW10
PRODUCT
PRODUCTIF
RADIANS
RAND
ROUND
ROUNDE
ROUNDO
ROUNDX
SCM
SGN
SHIFTL
SHIFTR
SQR
SQRT
SUBTOTAL
SUM
SUM2
SUM3
SUMIF
SUM2IF



SUM3IF
SUM_EX
TRUNC
XOR

Hyperbolic functions

ARCOSH
ARSINH
ARTGH
COSH
COSECH
SECH
SINH
TANH

Trygonometrical functions

ACOS
ASIN
ATAN
COS
SIN
TAN



Statistical functions

AVE
AVE2
AVEG
AVEH
CHI2
STD
CORREL
ENTROPY
ERF
ERFV
EST
ESTN



Text functions

BIN
CHAR
CODE
ETEXT
EXACT
FIND
HEX
LEFT
LENGTH
LOWER
LTRIM
MERGE
MID
NUM2STR
OCT
PROPER
REPEAT
REPLACE
RIGHT
RTRIM
STEXT
TEXT
TRAIL
TRIM
UPPER
VALUE



Financial functions

CTERM
FV
FVAL
PMT
PV
RATE
SLN
SYD
TERM



Date/Time functions

DATE
DATEDIF
DATEVALUE
DAY
DAYOFWEEK
DAYOFYEAR
FORMATDATE
FORMATTIME
HOUR
MINUTE
MONTH
NOW
SECOND
TIME
TIMEVALUE
TODAY
YEAR



Lookup and Reference functions

ADDRESS
AREA
CELL
CELL_EX
COLS
COUNT
COUNTV
FOLDER_COUNT
GETEXVAL
HLOOKUP
INDEX
MATCH
SHEET_COUNT
OBJECT_COUNT
OFFSET
RANGE
ROWS
VLOOKUP



Logical functions

HAS_OBJECT
IF
ISERROR
ISFILE
ISNUMBER
ISOPEN
ISSTRING
TEST



Special functions

OPENDOC
OPENSHEET
MESSAGE
PLAYSOUND



ABS(Number)

Returns the absolute value of Number.

Example: ABS(-10) = 10



SGN(Number)

Returns -1 if Number < 0, 0 if Number = 0 and 1 if Number > 0.

Example: SGN(10) = 1



AND(Number1; Number2)

Returns the bitwise AND of Number1 and Number2.

Example: AND(12; 4) = 4



NOT(Number)

Returns the bitwise negation of Number.

Example: NOT(10) = -11



OR(Number1; Number2)

Returns the bitwise OR of Number1 and Number2.

Example: OR(8; 4) = 12



XOR(Number1; Number2)

Returns the bitwise XOR of Number1 and Number2.

Example: XOR(12; 4) = 8



ARCOSH(Number)

Returns the inverse hyperbolic cosine of Number.

Example: ARCOSH(1.5) = 0.96242365



ARSINH(Number)

Returns the inverse hyperbolic sine of Number.

Example: ARSINH(1.5) = 1.19476322



ARTGH(Number)

Returns the inverse hyperbolic tangent of Number.

Example: ATGH(0.5) = 0.54930614



COSECH(Number)

Returns the hyperbolic cosecant of Number.

Example: COSECH(1.5) = 0.46964244



COSH(Number)

Returns the hyperbolic cosine of Number.

Example: COSH(1.5) = 2.35240962



SECH(Number)

Returns the hyperbolic secant of Number.

Example: SECH(1.5) = 0.42509603



SINH(Number)

Returns the hyperbolic sine of Number.

Example: SINH(1.5) = 2.12927946



TANH(Number)

Returns the hyperbolic tangent of Number.

Example: TANH(1.5) = 0.90514825



ACOS(Number)

Returns the arccosine of Number.

Example: ACOS(0.5) = 1.04719755 (=PI/3) 



ASIN(Number)

Returns the arcsine of Number.

Example: ASIN(0.5) = 0.52359878 (=PI/6)



ATAN(Number)

Returns the arctangent of Number.

Example: ATAN(1) = 0.78539816 (PI/4)



COS(Number)

Returns the cosine of Number.

Example: COS(PI(1)/3) = 0.5



SIN(Number)

Returns the sine of Number.

Example: SIN(PI(1)/6) = 0.5



TAN(Number)

Returns the tangent of Number.

Example: TAN(PI(1)/4) = 1



BJ0(Number)

Returns the value of the Bessel function of the first kind and zero level for Number.

Example: BJ0(0.9) = 0.8075238



BJ1(Number)

Returns the value of the Bessel function of the first kind and second level for Number.

Example: BJ1(0.9) = 0.40594955



BJN(Level; Number)

Returns the value of the Bessel function of the first kind for the given Level    and Number.

Example: BJN(1;0.9) = 0.40594955



BY0(Number)

Returns the value of the Bessel function of the second kind and zero level for Number.

Example: BY0(0.9) = 0.00562831



BY1(Number)

Returns the value of the Bessel function of the second kind and first level for Number.

Example: BY1(0.9) = -0.87312658



BYN(Level; Number)

Returns the value of the Bessel function of the second kind for the given Level    and Number.

Example: BY1(1; 0.9) = -0.87312658



DEGREES(Number)

Converts Number, which represents an angle in radians, to degrees.

Example: DEGREES(PI(1)/4) = 45



RADIANS(Number)

Converts Number, which represents an angle in degrees, to radians.

Example: RADIANS(45) = 0.78539816 (=PI(1)/4)



EXPM(Number)

Returns the mantissa m of Number (m is greater than or equal to 0.5 and less than 1) so that Number = m*2^k, 
where k is the exponent.

Example: EXPM(1.5) = 0.75



EXPE(Number)

Returns the exponent k of Number so that Number = m*2^k, where m is the mantissa.

Example: EXPE(1.5) = 1



EXP(Number)

Returns the base of the natural logarithm ("e") raised to the power of Number.

Example: EXP(2) = 7.3890561



FACT(Number)

Returns the factorial of Number: the product of all integers greater than zero and not greater than Number.

Example: FACT(5) = 120



GCD(Number1; Number2)

Returns the greatest common divisor of Number1 and Number2.

Example: GCD(24;16) = 8



SCM(Number1; Number2)

Returns the smallest common multiplicity of Number1 and Number2.

Example: SCM(12; 8) = 24



LOG10(Number)

Returns the base 10 logarithm of Number.

Example: LOG10(100) = 2



LOG(Number)

Returns the natural logarithm of Number.

Example: LOG(EXP(2)) = 2



LOGX(Number; Base)

Returns the Base logarithm of Number.

Example: LOGX(2^5; 2) = 5



MOD(Number1; Number2)

Returns the reminder of Number1 / Number2.

Example: MOD(9; 4) = 1



POW10(Number)

Returns 10 to the power of Number.

Example: POW10(2) = 100



PI(Number)

Returns the product of Number and the value PI (3.141592653589).

Example: PI(1) = 6.2831853



CEIL(Number)

Returns a number representing the smallest integer greater than or equal to Number.

Example: CEIL(2.6) = 3



ROUND(Number)

Returns Number rounded to the nearest integer.

Example: ROUND(2.4) = 2



ROUNDE(Number)

Returns Number rounded to the nearest even number.

Example: ROUNDE(3.1) = 4

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier 
version of GS-Calc. In GS-Calc 4.0 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



EVEN(Number)

Returns Number rounded to the nearest even number.

Example: EVEN(3.1) = 4



ROUNDO(Number)

Returns Number rounded to the nearest odd number.

Example: ROUNDO(2.1) = 3

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier 
version of GS-Calc. In GS-Calc 4.0 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



ODD(Number)

Returns Number rounded to the nearest odd number.

Example: ODD(2.1) = 3



ROUNDX(Number; Precision)

Returns Number rounded to the factor specified by Precision.

Example: ROUNDX(2.1; 0.5) = 2.5



TRUNC(Number)

Returns the integer portion of Number.

Example: TRUNC(2.5) = 2



SHIFTL(Number; Positions)

Returns the value of Number after shifting its bits by Positions to the left.

Example: SHIFTL(2; 3) = 16



SHIFTR(Number; Positions)

Returns the value of Number after shifting its bits by Positions to the right.

Example: SHIFTR(16; 3) = 2



SQR(Number)

Returns the square of Number.

Example:SQR(3) = 9



SQRT(Number)

Returns the square root of Number.

Example: SQRT(9) = 3



INTERPOL(X_range; Y_range; Point)

Performs interpolation of a function in Point based on points from X_range and function values from Y_range.

Example: INTERPOL(A1:A10; B1:B10; 3) = 2.3



AREA(Range)

Returns the number of cells in Range.

Example: AREA(A1:B10) = 20



AVE(Range)

Returns the arithmetic mean for cells in Range.

Exampe: AVE(A1:B10) = 1.1



AVE2(Range)

Returns the square mean for cells in Range.

Example: AVE2(A1:B10) = 1.1



AVEG(Range)

Returns the geometric mean for cells in Range.

Example: AVEG(A1:B10) = 1.1



AVEH(Range)

Returns the harmonic mean for cells in Range.

Example: AVEH(A1:B10) = 1.1



CHI2(Degree; Chi2Expression)

Returns the confidence level for Chi2Expression, which has the chi-square distribution.

Example: CHI2(4; 1.1) = 0.89427221



STD(Degree; TExpression)

Returns the confidence level for TExpression, which has the Student distribution.

Example: STD(4; 1.1) = 0.33308365



COMBNR(n;k)

Returns the number of k-element combinations with repeating from the n-element set.

Example: COMBNR(5; 3) = 35



COMBNS(n; k)

Returns the number of k-element combinations without repeating from the n-element set.

Example: COMBNS(5; 3) = 10



CORREL(Range1; Range2)

Returns the correlation between numbers from Range1 and Range2.

Example: CORREL(A1:A10; B1:B10) = 0.9



COUNT(Range)

Returns the number of not empty cells in the given range.

Example: COUNT(A1:B10) = 4



COUNTV(Value; SearchRange)

Returns the number of cells containing Value in the given range. Value may represent a number or a text.

Example: COUNTV(2.2; A1:B10) = 3



ENTROPY(Range)

Returns the entropy of an information source based on probability factors from the given range.

Example: ENTROPY(A1:A2) = 1



ERF(Number)

Returns the integral of the Gauss function in the range {-Number*sqrt(2), Number*sqrt(2)}.

Example: ERF(1.5) = 0.96610809



ERFV(Number)

Returns the argument for which the ERF function returns Number.

Example: ERFV(0.96610809) = 1.5



EST(Range)

Returns the standard deviation of a sample from the given range.

Example: EST(A1:B10) = 1.1



ESTN(Range)

Returns the standard deviation of a population.

Example: ESTN(A1:B10) = 1.1



GRANDTOTAL(Range)

Returns the sum of values of formulas from the given range containing the SUBTOTAL function.

Example: GRANDTOTAL(A1:B10) = 12



SUBTOTAL(Range)

Returns the sum of numbers from the given range.

Example: SUBTOTAL(A1:B10) = 12



MAX(Range)

Returns the largest number in the given range.

Example: MAX(A1:B10) = 5



MAX_EX(Range)

Returns the largest number in the given range in all worksheets from the current folder and its subfolders except 
the active worksheet.

Example: MAX_EX(A1:B5) = 10



MIN(Range)

Returns the smallest number in the given range.

Example: MIN(A1:B10) = -1



MIN_EX(Range)

Returns the smallest number in the given range in all worksheets from the current folder and its subfolders except 
the active worksheet.

Example: MIN_EX(A1:B5) = 10



PRODUCT(Range)

Returns the product of not empty cells from the given range.

Example: PRODUCT(A1:B10) = 24.6



RAND(Number)

Returns a random number greater or equal to 0 and less or equal to Number.

Example: RAND(60) = 34.56



SUM(Range)

Returns the sum of numbers from the given range.

Example: SUM(A1:B10) = 14



SUM_EX(Range)

Returns the sum of numbers from the given range for all worksheets from the current folder and its subfolders 
except the active worksheet.

Example: SUM_EX(A1:B10)



SUM2(Range)

Returns the sum of squares of numbers from the given range.

Example: SUM2(A1:B10) = 34



SUM3(Range)

Returns the sum of cubes of numbers from the given range.

Example: SUM3(A1:B10) = 46.55



PRODUCTIF(Value1; Value2; ConditionsRange; InputRange)

Returns the product of numbers from InputRange. Finds only those numbers, for which values at the same position 
in ConditionRange fulfill the requirements:
(a) value > Value1 and value < Value2 if Value1 and Value2 are not equal
or
(b) value = Value1 if Value1 is equal to Value2.
Value1 and Value2 may represent numbers or text strings. ConditionRage and InputRange must contain the same 
number of cells.

Example: PRODUCTIF(10248; 10252; A2:A7; C2:C7) = 72



SUMIF(Value1; Value2; ConditionsRange; InputRange)

Returns the sum of numbers from InputRange. Finds only those numbers, for which values at the same position in 
ConditionRange fulfill the requirements:
(a) value > Value1 and value < Value2 if Value1 and Value2 are not equal
or
(b) value = Value1 if Value1 is equal to Value2.
Value1 and Value2 may represent numbers or text strings. ConditionRage and InputRange must contain the same 
number of cells.

Example: SUMIF(10248; 10252; A2:A7; C2:C7) = 13



SUMIF2(Value1; Value2; ConditionsRange; InputRange)

Returns the sum of squares of numbers from InputRange. Finds only those numbers, for which values at the same 
position in ConditionRange fulfill the requirements:
(a) value > Value1 and value < Value2 if Value1 and Value2 are not equal
or
(b) value = Value1 if Value1 is equal to Value2.
Value1 and Value2 may represent numbers or text strings. ConditionRage and InputRange must contain the same 
number of cells.

Example: SUM2IF(10248; 10252; A2:A7; C2:C7) = 61



SUMIF3(Value1; Value2; ConditionsRange; InputRange)

Returns the sum of cubes of numbers from InputRange. Finds only those numbers, for which values at the same 
position in ConditionRange fulfill the requirements:
(a) value > Value1 and value < Value2  if Value1 and Value2 are not equal
or
(b) value = Value1 if Value1 is equal to Value2.
Value1 and Value2 may represent numbers or text strings. ConditionRage and InputRange must contain the same 
number of cells.

Example: SUM2IF(10248; 10252; A2:A7; C2:C7) = 307



BIN(Number)

Returns the text string representing Number in the binary notation.

Example: BIN(23) = "10111"



CHAR(Number)

Returns a text string consisting of one character with the character set code equal to Number.

Example: CHAR(65) = "A"



CODE(Text)

Returns the character set code of the first character in Text.

Example: CODE("Word") = 87



HEX(Number)

Returns the text string representing Number in the hex notation.

Example: HEX(1998) = "7ce"



KWOTA(Number)



OCT(Number)

Returns the text string representing Number in the octal notation.

Example: OCT(1998) = "3716"



TEXT(Number)

Returns the text string representing Number in textual ("verbal") form.

Example: TEXT(23) = "twenty three"



EXACT(Text1; Text2)

Compares two text strings. If Text1 = Text2, 1 (True) is returned. If they are different, 0 (False) is returned. The 
comparison is case-sensitive.

Example: EXACT("Thing"; "Thing") = 1



FIND(Text1; Text2; Position)

Returns the position (as a 1-base index) of Text1 in Text2. Searching starts in Text2 from Position.

Example: FIND("word"; "two words"; 1) = 5



LEFT(Text; Number)

Returns the first Number characters from Text.

Example: LEFT("abcdef"; 3) = "abc"



LENGTH(Text)

Returns the length of Text.

Example: LENGTH("abcdef") = 6



LOWER(Text)

Converts all letters in Text    to lowercase.

Example: LOWER("ABCDEF") = "abcdef"



REPLACE(Text1; Number1; Number2; Text2)

Replaces Number2 characters in Text1 starting from Number1 position by Text2. For the first character in Text1 
Number1 = 1.

Example: REPLACE("abcdef"; 3; 2; "x") = "abxef"



STEXT(Text)

Converts all letters in Text    to lowercase.

Example: STEXT("ABCDEF") = "abcdef"

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier 
version of GS-Calc. In GS-Calc 4.0 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



MID(Text; StartPosition; EndPosition)

Returns the substring of Text. The substring starts at StartPosition and includes all characters up to EndPosition. The
position of the first character in Text is 1.

Example: MID("abcdef"; 3; 4) = "cd"



PROPER(Text)

Converts first letters of words in Text to uppercase and all other letters to lowercase.

Example: PROPER("two WORDS") = "Two Words"



REPEAT(Text; Number)

Returns string that consists of Text repeated Number times.

Example: REPEAT("abc "; 3) = "abc abc abc "



RIGHT(Text; Number)

Returns the last Number characters from Text.

Example: RIGHT("abcdef"; 3) = "def"



TRIM(Text)

Removes all trailing and leading whitespaces from Text.

Example: TRIM("      abcdef      ") = "abcdef"



LTRIM(Text)

Removes all leading whitespaces from Text.

Example: LTRIM("      abcdef") = "abcdef"



RTRIM(Text)

Removes all trailing whitespaces from Text.

Example: RTRIM("abcdef      ") = "abcdef"



UPPER(Text)

Converts all letters in Text    to uppercase.

Example: UPPER("abcdef") = "ABCDEF"



ETEXT(Text)

Converts all letters in Text    to uppercase.

Example: ETEXT("abcdef") = "ABCDEF"

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier 
version of GS-Calc. In GS-Calc 4.0 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



TRAIL(Text; Number)

If Text length is less than Number, this function adds trailing spaces to Text so that Text contains exactly of Number 
characters.

Example: TRAIL("abc", 6) = "abc      "



VALUE(Text)

Converts Text to number.

Example: VALUE("123") = 123



NUM2STR(Number; Radix)

Returns the text string representing Number in the Radix notation.

Example: NUM2STR(1998; 10) = "1998"



MERGE(Text1; Text2)

Returns the text string consisting of merged Text1 and Text2.

Example: MERGE("abc"; "def") = "abcdef"



CTERM(Rate; Fv; Pv)

Returns the number of compounding periods after which the initial amount (Pv) will obtain the value specified by Fv 
at the given interest rate Rate.

Example: CTERM(9%/12; 10000; 5000) = 92.76576606



FVAL(Pv; Rate; Periods)

Returns the future value of an investment or loan Pv (with no periodic payments) at the given interest rate and the 
given number of periods.

Example: FVAL(5000; 9%/12; 93) = 10017.51731932



FV(Payment; Rate; Periods)

Returns the future value of an investment (with periodic payments) after the given number of periods and with the 
given interest rate.

Example: FV(500; 9%/12; 24) = 13094.23529284



PMT(Pv; Rate; Periods)

Returns the payment amount for a loan during the given number of periods.

Example: PMT(20000; 9%/12; 24) = 913.69484558



PV(Payment; Rate; Periods)

Returns the present value for a loan or investment.

Example: PV(500; 9%/12; 24) = 10944.57306872



RATE(Fv; Pv; Periods)

Returns the periodic interest rate for a loan or investment (Pv) at the given number of periods.

Example: RATE(10000; 5000; 48) = 0.01454533



SLN(Cost; Salvage; Life)

Returns the straight-line depreciation for one period.

Example: SLN(3000; 400; 5) = 520



SYD(Cost; Salvage; Life; Period)

Returns the sum-of-the-years'-digits' depreciation for the given period.

Example: SYD(3000; 400; 5; 4) = 346.66666667



TERM(Payment; Rate; Pv)

Returns the number of payment periods for an investment or loan (Pv) with the given interest rate and payment.

Example: TERM(500; 9%/12; 10000) = 18.7047196



DATE(Year; Month; Day)

Returns the date/time number for the given Year, Month and Day. This integer portion represents the number of 
days since December 30, 1899, midnight and the fractional portion represents hours.

Example: DATE(1998; 1; 1) = 35796



TIME(Hour; Minute; Second)

Returns the date/time number for the given Year, Month and Day. This integer portion represents the number of 
days since December 30, 1899, midnight and the fractional portion represents hours.

Example: TIME(11; 53; 44) = 0.49564815



DATEDIF(DateNumber1; DateNumber2; Type)

Calculates the difference between two dates. The result depends on Type:
1 - difference as the number of days
2 - remaining hours of the difference
3 - remaining minutes of the difference
4 - remaining seconds of the difference
5 - difference as the total number of hours
6 - difference as the total number of minutes
7 - difference as the total number of seconds

Example: DATEDIF(DATE(1998;3;1)+TIME(10;45;0); DATE(1998;1;1)+TIME(9;45;0); 6) = 85020    (minutes)



DATEVALUE(Text)

Returns the date/time number for the given date string Text. To be parsed correctly, the text string must conform to 
the currently defined in system short date/time format.

Example: DATEVALUE("13/1/98") = 35808



TIMEVALUE(Text)

Returns the date/time number for the given time string Text. To be parsed correctly, the text string must conform to 
the currently defined in system short date/time format.

Example: TIMEVALUE("9:45:34 PM") = 0.90664352



DAY(DateNumber)

Returns the day of the month (1-31) for the DateNumber.

Example: DAY(DATE(1998;1;1)) = 1



HOUR(DateNumber)

Returns the hour(0-23) for the DateNumber.

Example: HOUR(TIME(23;12;56)) = 23



MINUTE(DateNumber)

Returns the minute (0-59) for the DateNumber.

Example: MINUTE(TIME(23;12;56)) = 12



SECOND(DateNumber)

Returns the second (0-59) for the DateNumber.

Example: SECOND(TIME(23;12;56)) = 56



MONTH(DateNumber)

Returns the month (1-12) for the DateNumber.

Example: MONTH(DATE(1998;1;1)) = 1



YEAR(DateNumber)

Returns the year for the DateNumber.

Example: YEAR(DATE(1998;1;1)) = 1998



DAYOFWEEK(DateNumber)

Returns the day of the week (Sun = 1) for the DateNumber.

Example: DAYOFWEEK(DATE(1998;1;1)) = 5 



DAYOFYEAR(DateNumber)

Returns the day of the year (Jan 1 = 1) for the DateNumber.

Example: DAYOFYEAR(DATE(1998;1;1)) = 1



FORMATDATE(DateNumber; FormattingText)

Returns the text representing date/time formatted according to FormattingText. If FormattingText is an empty string
(""), the default Windows format for the date representation is used. Otherwise, it may contain any text combined 
with the following special character sequences:

%a      Abbreviated weekday name
%A      Full weekday name
%b      Abbreviated month name
%B      Full month name
%c      Date and time representation appropriate for locale
%d      Day of month as decimal number (01 – 31)
%H      Hour in 24-hour format (00 – 23)
%I      Hour in 12-hour format (01 – 12)
%j      Day of year as decimal number (001 – 366)
%m      Month as decimal number (01 – 12)
%M      Minute as decimal number (00 – 59)
%p      Current locale’s A.M./P.M. indicator for 12-hour clock
%S      Second as decimal number (00 – 59)
%U      Week of year as decimal number, with Sunday as first day of week (00 – 51)
%w      Weekday as decimal number (0 – 6; Sunday is 0)
%W      Week of year as decimal number, with Monday as first day of week (00 – 51)
%x      Date representation for current locale
%X      Time representation for current locale
%y      Year without century, as decimal number (00 – 99)
%Y      Year with century, as decimal number
%z, %Z      Time-zone name or abbreviation; no characters if time zone is unknown
%%      Percent sign
%#c      Long date and time representation
%#x      Long date representation, appropriate to current locale
%#d, %#H, %#I, %#j, %#m, %#M, %#S, %#U, %#w, %#W, %#y, %#Y      Remove leading zeros in the values 
explained above

Example:
      FORMATDATE(DATE(1998;1;1); "") = "1/1/98"
      FORMATDATE(DATE(1998;1;1); "%A, %B") = "Thursday, January"
      FORMATDATE(DATE(1998;1;1)+TIME(10;30;0); "%#c") = "Thursday, January 01, 1998 10:30:00"



FORMATTIME(DateNumber; FormattingText)

Returns the text representing date/time formatted according to FormattingText. If FormattingText is an empty string
(""), the default Windows format for the date representation is used. Otherwise, it may contain any text combined 
with the following special character sequences:

%a      Abbreviated weekday name
%A      Full weekday name
%b      Abbreviated month name
%B      Full month name
%c      Date and time representation appropriate for locale
%d      Day of month as decimal number (01 – 31)
%H      Hour in 24-hour format (00 – 23)
%I      Hour in 12-hour format (01 – 12)
%j      Day of year as decimal number (001 – 366)
%m      Month as decimal number (01 – 12)
%M      Minute as decimal number (00 – 59)
%p      Current locale’s A.M./P.M. indicator for 12-hour clock
%S      Second as decimal number (00 – 59)
%U      Week of year as decimal number, with Sunday as first day of week (00 – 51)
%w      Weekday as decimal number (0 – 6; Sunday is 0)
%W      Week of year as decimal number, with Monday as first day of week (00 – 51)
%x      Date representation for current locale
%X      Time representation for current locale
%y      Year without century, as decimal number (00 – 99)
%Y      Year with century, as decimal number
%z, %Z      Time-zone name or abbreviation; no characters if time zone is unknown
%%      Percent sign
%#c      Long date and time representation
%#x      Long date representation, appropriate to current locale
%#d, %#H, %#I, %#j, %#m, %#M, %#S, %#U, %#w, %#W, %#y, %#Y      Remove leading zeros in the values 
described above

Example:
      FORMATTIME(TIME(10;30;45); "") = "10:30:45 AM"
      FORMATTIME(TIME(10;30;45); "minutes: %M, seconds: %S") = "minutes: 30, seconds: 45"
      FORMATTIME(DATE(1998;1;1)+TIME(10;30;0); "%#c") = "Thursday, January 01, 1998 10:30:00"



TODAY(DaysNumber)

Returns the current date/time string +/- DaysNumber.

Example: TODAY(0) = "12/11/97"



NOW(HoursNumber)

Returns the current date/time string +/- HoursNumber.

Example: NOW(0) = "2:49:43 PM"



COLS(Range)

Returns the number of columns in Range.

Example: COLS(A1:B10) = 2



ROWS(Range)

Returns the number of rows in Range.

Example: ROWS(A1:B10) = 10



HLOOKUP(SearchItem; SearchRange; RowIndex)

SearchItem is compared against values in the first row of SearchRange. If a matching value is found, the contents of
the cell from the corresponding column and the RowIndex row are returned. If SearchItem can not be found in the 
first row of SearchRange, the largest value that is less than SearchItem is used. SearchItem and the cells from the 
first row of SearchRange may represent numbers or text. The data in the first row of SearchRange must be sorted in
ascending order. The RowIndex numbering starts from 1 (the first row of SearchRange). If no matching value is 
found, the error value is returned. The search in not case-sensitive.

Example: HLOOKUP(10251; B1:F4; 3) = 3



VLOOKUP(SearchItem; SearchRange; ColumnIndex)

SearchItem is compared against values in the first column of SearchRange. If a matching value is found, the 
contents of the cell from the corresponding row and the ColumnIndex column are returned. If SearchItem can not be
found in the first column of SearchRange, the largest value that is less than SearchItem is used. SearchItem and the
cells from the first column of SearchRange may represent numbers or text. The data in the first column of 
SearchRange must be sorted in ascending order. The RowIndex numbering starts from 1 (the first column of 
SearchRange). If no matching value is found, the error value is returned. The search in not case-sensitive.

Example: VLOOKUP(10252; A2:D7; 4) = "7/6/93"



INDEX(Range; ColumnNumber; RowNumber)

Returns the contents of the cell from Range. The cell position is relative to Range, i.e. ColumnNumber equal to 1 
and RowNumber equal to 1 refers to the upper left corner of Range.

Example: INDEX(A1:B10; 1; 1)    (= A1)



RANGE(LeftColumn; TopRow; RightColumn; BottomRow)

Creates and returns the range specified by two columns LeftColumn, RightColumn (1-512) and two rows TopRow, 
BottomRow (1-8192).

Example: RANGE(1; 1; 2; 10)    (=A1:B10)



MATCH(SearchItem; SearchRange; SearchType)

SearchItem is compared against values in the given range. If found, the position of the matching value is returned. 
If there is no matching value, the error value is returned. The following search types may be specified:
0 - search for the first value equal to SearchItem
1 - search for the biggest value equal to or less than SearchItem
2 - search for the smallest value equal to or greater than SearchItem
SerachItem may represent a number or a text. The first position in SearchRange is equal to 1. SearchRange does 
not have to be sorted. The search in not case-sensitive.

Example:
      MATCH("victe"; A2:D7; 0) = 14
      MATCH(10250.5; A2:A7; 1) = 3



ADDRESS(ColumnNumber; RowNumber)

Returns the cell address specified as ColumnNumber (1 - 512) and RowNumber (1 - 8192).

Example: ADDRESS(3; 4)    (=C4)



CELL(Feature; CellAddress)

Returns the chosen feature of a cell. Feature may have one of the following values:
0 - cell column is returned
1 - cell row is returned
2 - cell value is returned

Example: CELL(0; B5) = 2



CELL_EX(Feature; CellAddress; Worksheet)

Returns the chosen feature of a cell from another worksheet in the same file. Feature may have one of the following
values:
0 - cell column is returned
1 - cell row is returned
2 - cell value is returned

A full path (incl. the initial backslash) must be used to access worksheets in other (non-descendant) folders. For 
worksheets in the same folder and its subfolders you may use a relative path.

Example:
CELL_EX(2; B5; "\Reports\July\021") = 2
CELL_EX(2; B5; "July\021") = 2
CELL_EX(2; B5; "021") = 2



OFFSET(Range; ColumnsNumber; RowsNumber)

Returns Range shifted horizontally and/or vertically by ColumnsNumber and RowsNumber.

Example: OFFSET(A1:B10; 1; 1)    (=B2:C11)



GETEXVAL(Document; CellAddress; AutoOpen)

Returns the value of the specified cell from another spreadsheet document and the default worksheet (that is, a 
worksheet that was active when the document was saved). Document should contain the full path of an existing 
*.gsc file. Before obtaining this value, Document must be opened. If AutoOpen is equal to 1, Document is opened 
automatically. If AutoOpen is equal to 0 and Document is not loaded, the error value is returned.

Example: GETEXVAL("d:\gscalc47\analyze.gsc"; E9; 1) = 100



OBJECT_COUNT(Type)

Returns the number of objects of the given Type (0 - any object, 1 - OLE objects, 2 - charts, 3 - rectangles or 
ellipses) in the current worksheet.

Example: OBJECT_COUNT(2) = 1



SHEET_COUNT(Type)

Returns the number of worksheets in the current folder and its subfolders if Type = 1 or in all folders if Type = 0.

Example: SHEET_COUNT(0) = 1



FOLDER_COUNT(Type)

Returns the number of folders in the current folder and its subfolders if Type = 1 or in all folders if Type = 0.

Example: FOLDER_COUNT(0) = 1



TEST(Number; TrueValue; FalseValue)

If Number is greater than or equal to 0, the TrueValue is returned. If Number is less than 0, FalseValue is returned. 
TrueValue and FalseValue may represent any text or numbers.

Example: TEST(10; "abc"; "cde") = "abc"

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier 
version of GS-Calc. In GS-Calc 4.0 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



HAS_OBJECT(Type)

Returns 1 if the current worksheet contains an object of the given Type (0 - any object, 1 - OLE object, 2 - chart, 3 - 
rectangle or ellipse) or 0 otherwise.

Example: HAS_OBJECT(2) = 1



IF(Condition; TrueValue; FalseValue)

If Condition, which may be any expression returning numbers, is different than 0, the TrueValue is returned. If 
Condition is equal to 0, FalseValue is returned. TrueValue and FalseValue may represent any text or numbers.

Example: IF((A1>1)*(A1<10); 1; 2) = 1



ISERROR(Value)

Returns 1 (True) if Value represents the error value or a range containing at least one error value. If no error is 
found, 0 is returned.

Example: ISERROR(1/0) = 1



ISNUMBER(Value)

Returns 1 (True) if Value represents a number, cell or a range containing (only) numbers or expressions returning 
numbers. Otherwise 0 (False) is returned.

Example: ISNUMBER(12) = 1



ISSTRING(Value)

Returns 1 (True) if Value represents a text string or a range containing only text. Otherwise 0 (False) is returned.

Example: ISSTRING("abc") = 1



ISFILE(Text)

Returns 1 (True) if Text represents a name of an existing file or 0 (False) otherwise.

Example: ISFILE("d:\gscalc47\analyze.gsc") = 1



ISOPEN(Text)

Returns 1 (True) if Text represents a name (full path) of the currently open spreadsheet document or 0 (False) 
otherwise.

Example: ISOPEN("d:\gscalc47\analyze.gsc") = 1



PLAYSOUND(Condition; SoundName; Type)

If Condition, which may be any expression returning numbers, is different than 0, this function plays sound specified
as SoundName. If Type is equal to 1, SoundName is assumed to be a complete file path, otherwise it's treated as a 
system sound name alias.

Example: PLAYSOUND(ISERROR(B15); "c:\sound\theme.wav"; 1)



OPENDOC(Condition; Document)

If Condition, which may be any expression returning numbers, is different than 0, this function opens a document 
specified as Document. This can be a complete file path of the given document, executable file name, name of a 
folder or an Internet URL.

Example:
      OPENDOC(B15 > 10000; "d:\report.txt")
      OPENDOC(B15="xyz"; "http://www.xyz.com")
      OPENDOC(B15=10; "d:\gsbase47\gsbase.exe")



OPENSHEET(Condition; SheetName)

If Condition, which may be any expression returning numbers, is different than 0, this function opens an existing 
spreadsheet document specified as SheetName. SheetName must contain a full path name of a given document.

Example: OPENSHEET(B15<100; "d:\form1.gsc")



MESSAGE(Condition; MessageText)

If Condition, which may be any expression returning numbers, is different than 0, this function displays a message 
specified as MessageText.

Example: MESSAGE(ISERROR(B15); "Error Value in B15!")





Print command (File menu)

Use this command to print a document. This command presents a Print dialog box, where you may specify the range of pages to 
be printed, the number of copies, the destination printer, and other printer setup options.



Print All command (File menu)

Use this command to print all worksheets from the current folder (that is, from the folder containing the current worksheet) and its 
subfolders.



Print dialog box

See: Print command.



Print Progress Dialog

The Printing dialog box is shown during the time that GS-Calc is sending output to the printer. The page number indicates the 
progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed. When you choose this command, the main 
window will be replaced with a print preview window in which one or two pages will be displayed in their printed format. The print 
preview toolbar offers you options to view either one or two pages at a time; move back and forth through the document; zoom in 
and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents the Print Setup dialog box where you 
specify the printer and its connection.



Print Setup dialog box

See: Print Setup command.





Paste Link command (Edit menu)

Use this command to paste link. This command is inactive when the Clipboard doesn't contain any link.



Links command (Edit menu)

Use this command to display the Links dialog box which lets you edit links between your document and other documents.

This command is unavailable if you have no links in your document.



Links dialog box

See: Links command



Object verb (Edit menu)

After selecting an OLE object this command is replaced by a new menu. Its contents depends on what type of object you selected.



New Object (Insert menu)

Inserts and embeds an object in a document. The application in which the object was created becomes active on the screen.

Select the object you want to insert into your document using the Insert New Object dialog box.



Insert New Object dialog box

See: New Object.



Paste Special command (Edit menu)

Use this command to paste the Clipboard contents using one of the available formats.



Paste Special dialog box

See: Paste Special command



Update command

Use this command to update the currently edited GS-Calc objects which are not updated automaticaly. 



Save Copy As... command

Use this command to create and save a new copy of the currently edited GS-Calc object.



OLE object frame

If you want to change the position or size of the currently edited OLE object, move or change the size of the frame displayed around 
it.




